CSc 430 – Quiz #2 – Professor Domanski – Sample Questions and Answers

1. The property that is used to control how text appears in a masked edit control is:

a) Text.

b) Caption.

c) Mask.

d) SelLength


Answer:
C
Section Reference:
Section 3.1

2. The VB control that can be used to enforce a desired input pattern is the:

a) text box.

b) list box.

c) masked edit box.

d) label.


Answer:
C
Section Reference:
Section 3.1

3. The control that prompts the user for a file to open is the:

a) MsgBox.

b) InputBox.

c) open file dialog.

d) StreamReader object.


Answer:
C
Section Reference:
Section 6.1

4. To display an open file dialog, use the:

a) ShowDialog method.

b) ShowDialog object.

c) Display method.

d) Filter property.


Answer:
A
Section Reference:
Section 6.1

5. Given an open file dialog box named cdlOpenFile, the correct syntax to have it display only Excel worksheets, which have an .xls extension, is:

a) cdlOpenFile.Title = “Worksheet Files”.

b) cdlOpenFile.Filter = “Worksheet Files”.

c) cdlOpenFile.Filter = “.xls”.

d) cdlOpenFile.Filter = “Worksheet Files (*.xls|)*.xls”.


Answer:
D
Section Reference:
Section 6.1

6. The file selected by the user in an open file dialog is stored in the:

a) AddExtension property.

b) FileName property.

c) ShowDialog method.

d) Filter property.


Answer:
B
Section Reference:
Section 6.1

7. Given a save file dialog control named cdlSave, the _________________ method will display the Save As dialog box.


Answer:
ShowDialog()
Section Reference:
Section 6.1

8. The file selected by the user from the open file dialog is stored in the _________________ property.


Answer:
FileName
Section Reference:
Section 6.1

9. To have a file open dialog display only text files, set the ______________ property to “Text Files(*.txt)|*.txt”


Answer:
Filter
Section Reference:
Section 6.1

10. The progress bar has Minimum and Maximum properties, with default values of:

a) 0 and 100, respectively.

b) 100 and 1000, respectively.

c) 0 and 1000, respectively.

d) 0 and 10, respectively.


Answer:
A
Section Reference:
Section 10.6

11. A ______________________ is a rectangular control used to display the progress of a procedure.


Answer:
progress bar
Section Reference:
Section 10.6

12. The first step to undertake before creating menus for your application is to:

a) identify the capabilities your application needs to provide.

b) decide how to group your application capabilities.

c) decide what menus your application needs to have.

d) decide whether to use menus or tree views.


Answer:
A
Section Reference:
Section 11.1

13. All of the following are important design considerations for menus except:

a) how logical the menus appear to the user.

b) how the system capabilities should be grouped.

c) consistency with other Windows applications.

d) the needs of the programmer.


Answer:
D
Section Reference:
Section 11.1

14. The control that is used to create menus is the:

a) command button.

b) main menu control.

c) window control.

d) Toolbox.


Answer:
B
Section Reference:
Section 11.1

15. To create an access key in a menu:

a) place an ampersand at the beginning of the menu text.

b) place an ampersand after the letter you want to serve as the access key.

c) place an ampersand before the letter you want to serve as the access key.

d) place an underscore before the letter you want to serve as the access key.


Answer:
C
Section Reference:
Section 11.1

16. To create an access key for a menu item, precede the letter you want to use as the access key with a(n):

a) underscore(_).

b) hyphen(-).

c) apostrophe(‘).

d) ampersand(&).


Answer:
D
Section Reference:
Section 11.1

17. When you see a menu item named File:

a) pressing the F key will open the menu.

b) pressing Ctrl + F will open the menu.

c) pressing Alt + F will open the menu.

d) pressing Shift + F will open the menu.


Answer:
C
Section Reference:
Section 11.1

18. To add a new form to a project:

a) Select Add Windows Form from the Project Menu.

b) Select Add Windows Form from the File Menu.

c) Select New from the Form Menu.

d) Select New Window from the Window Menu.


Answer:
A
Section Reference:
Section 11.3

19. The default startup form in a project is:

a) the last form added to the project.

b) the first form added to the project.

c) the form named frmStartup.

d) the standard module.


Answer:
B
Section Reference:
Section 11.3

20. When a form is displayed as a modeless form:

a) no other forms can receive focus until the form is closed.

b) no code in the procedure that opened the form can be executed until the form is closed.

c) the form acts independently of any other form.

d) both A and B.


Answer:
C
Section Reference:
Section 11.3

21. When a form is displayed as a modal form:

a) no other forms can receive focus until the form is closed.

b) the user can switch to another form by clicking on it.

c) procedures in the other form continue to be executed.

d) both B and C.


Answer:
A
Section Reference:
Section 11.3

22. Given a form named frmEmployee, with a text box named txtName, the correct syntax to retrieve the value of that text box from another form is:

a) frmEmployee.txtName.

b) frmEmployee.txtName.Text.

c) frmEmployee(txtName).

d) frmEmployee(txtName.Text).


Answer:
B
Section Reference:
Section 11.3

23. To make a variable accessible to any entity without restriction, declare the variable with the:

a) Public modifier.

b) Friend modifier.

c) Shared modifier.

d) Dim keyword.


Answer:
A
Section Reference:
Section 11.3

24. A variable declared with the Friend modifier is accessible:

a) to any entity without restriction.

b) to the Standard module.

c) to all modules in the current project.

d) to procedures in that module only.


Answer:
C
Section Reference:
Section 11.3

25. The module that contains code and data common to other code modules is a:

a) code module.

b) form module.

c) class module.

d) standard module.


Answer:
D
Section Reference:
Section 11.3

26. The maximum number of standard modules a project can contain is:

a) one.

b) two.

c) four.

d) as many as you need.


Answer:
D
Section Reference:
Section 11.3

27. Variables declared with a Public modifier in a standard module are recognized:

a) by all procedures in the current project.

b) only to procedures in that standard module.

c) by procedures in all standard modules.

d) to all procedures in all open projects.


Answer:
D
Section Reference:
Section 11.3

28. Given a form named frmStudents with a public function named CalculateGPA(StudentID), the correct syntax to call the function, passing in a variable named IDNum, and store the result in a variable named StudentGPA is:

a) StudentGPA=frmStudents.CalculateGPA(IDNum).

b) StudentGPA=frmStudents.CalculateGPA(StudentID)

c) StudentGPA=CalculateGPA(IDNum).

d) StudentGPA=CalculateGPA(StudentID).


Answer:
A
Section Reference:
Section 11.3

29. The ___________________ is used to store code for classes.


Answer:
class module
Section Reference:
Section 11.3

30. Each drawing method requires a Pen object specifying:

a) the font size.

b) the pen size.

c) the pen color.

d) the pen color and optionally, the pen size.


Answer:
D
Section Reference:
Section B.1

31. The methods that paint a shape with a given color are referred to as:

a) fill methods.

b) draw methods.

c) paint methods.

d) brush methods.


Answer:
A
Section Reference:
Section B.1

32. To draw any graphic on a control, there must be:

a) an event associated with the control.

b) a Graphic object associated with the control.

c) a System.Drawing object associated with the control.

d) a Paint method associated with the control.


Answer:
B
Section Reference:
Section B.1

33. With graphic objects, the standard unit of measurement is the:

a) inch.

b) bit.

c) pixel.

d) twip.


Answer:
C
Section Reference:
Section B.1

34. All of the following statements concerning controls that graphic objects are drawn on are true, except:

a) the horizontal coordinate increases from left to right.

b) the horizontal coordinate at the leftmost margin of a control is 0.

c) the vertical coordinate increases from top to bottom.

d) the vertical coordinate at the bottommost margin of a control is 0.


Answer:
D
Section Reference:
Section B.1

35. The object that uses an image to fill a specified area is the:

a) SolidBrush.

b) Brush.

c) TextureBrush.

d) ImageBrush.


Answer:
C
Section Reference:
Section B.1

36. The object that provides brushes with colors that are used for named Windows system colors is the:

a) SolidBrush.

b) SystemBrushes.

c) TextureBrush.

d) WindowsBrush.


Answer:
B
Section Reference:
Section B.1

37. The Rectangle structure contains:

a) four points.

b) two points.

c) a point specifying its upper left corner and a size specifying its height and width.

d) a point specifying its upper left corner and a point specifying its lower right corner.


Answer:
C
Section Reference:
Section B.1

38. Given a drag and drop operation to copy a file from a hard drive to a floppy disk, the icon representing the floppy disk is referred to as the:

a) source control.

b) file control.

c) disk control.

d) target control.


Answer:
D
Section Reference:
Section B.3

39. Operations that involve dragging an icon from one location to another to initiate certain activities are referred to as:

a) drag and drop.

b) DragEnter.

c) Mouse_Down

d) double clicking.


Answer:
A
Section Reference:
Section B.3

40. The property of the target control that must be set to True before drag and drop operations can be performed is:

a) DragEnter.

b) AllowDrop.

c) SizeMode.

d) TargetDrop.


Answer:
B
Section Reference:
Section B.3

41. The code to implement the procedures that are executed when the user releases the mouse on the target control is written in the:

a) DragEnter event of the target control.

b) AllowDrop event of the target control.

c) Mouse_Down event of the source control.

d) DragDrop event of the target control.


Answer:
D
Section Reference:
Section B.3

42. The correct syntax to copy data from a text box named txtStudent to the Windows clipboard when the user drags the text in the text box is:

a) txtStudent.Text.Copy.

b) txtStudent.DoDragDrop(Copy).

c) txtStudent.DoDragDrop(txtStudent.Text,DragDropEffects.Copy).

d) txtStudent.DoDragDrop(DragDropEffects.Copy).


Answer:
C
Section Reference:
Section B.3

43. To draw a solid rectangle, use the _______________ method.


Answer:
FillRectangle
Section Reference:
Section B.1

44. The correct syntax to specify the blue color is _________________.


Answer:
Color.Blue
Section Reference:
Section B.1

45. Each drawing method requires a ______________ object, which specifies the color and size.


Answer:
pen
Section Reference:
Section B.1

46. ___________________ provides an interesting and easy way for the user to specify operations that can be too complex to express by another means.


Answer:
Drag and drop
Section Reference:
Section B.3

47. Before a drag and drop operation can be performed, the target control’s ________________ property must be set to True.


Answer:
AllowDrop 
Section Reference:
Section B.3

48. The target control’s ___________________ event is triggered when the user drops the source on the target control and releases the mouse.


Answer:
DragDrop
Section Reference:
Section B.3

49. The StreamReader and StreamWriter objects are available under the:

a) IO object.

b) System.IO namespace.

c) System.IO object.

d) System namespace.


Answer:
B
Section Reference:
Section 6.1

To read data from a file, use the:

a) System.IO object.

b) StreamWriter method.

c) StreamReader method.

d) StreamReader object.


Answer:
D
Section Reference:
Section 6.1

50. To write data to a file, use the:

a) System.IO object.

b) StreamWriter object.

c) StreamReader method.

d) StreamWriter method.


Answer:
B
Section Reference:
Section 6.1

51. The statement to declare and create an object to read a text file named NamesAndAddresses.txt in your C:\Personal folder is:

a) Dim InputFile As New System.IO.StreamReader(“C:\Personal\NamesAndAddresses.txt”).

b) Dim InputFile = (“C:\Personal\NamesAndAddresses.txt”).

c) Dim InputFile As New System.IO.StreamWriter(“C:\Personal\NamesAndAddresses.txt”).

d) Dim InputFile As System.IO.StreamReader(“C:\Personal\NamesAndAddresses.txt”).


Answer:
A
Section Reference:
Section 6.1

52. Given a text file with each record on a separate line, the statement that will read one record at a time is:

a) the Peek method.

b) the WriteLine method.

c) the Read method.

d) the ReadLine method.


Answer:
D
Section Reference:
Section 6.1

53. To test to see if you are at the end of the file, use the:

a) Read method.

b) ReadLine method.

c) Peek method.

d) Close method.


Answer:
C
Section Reference:
Section 6.1

54. To dissociate a file from the StreamReader object and release the computer resources, use the:

a) Read method.

b) ReadLine method.

c) Peek method.

d) Close method.


Answer:
D
Section Reference:
Section 6.1

55. To read an entire file in one operation, use the:

a) ReadFile method.

b) ReadLine method.

c) ReadToEnd method.

d) Read method.


Answer:
C
Section Reference:
Section 6.1

56. The statement to declare and create an object to write to the end of a text file named MyFriends.txt in your C:\Personal folder is:

a) Dim OutputFile As New System.IO.StreamWriter(“C:\Personal\MyFriends.txt”).

b) Dim OutputFile As System.IO.StreamWriter(“C:\Personal\MyFriends.txt”).

c) Dim OutputFile As New System.IO.StreamWriter(“C:\Personal\MyFriends.txt”,False).

d) Dim OutputFile as New System.IO.StreamWriter(“C:\Personal\MyFriends.txt”,True).


Answer:
D
Section Reference:
Section 6.1

57. To append data to an existing text file (rather than deleting the existing contents), the _______________ property must be set to True.

a) AppendMode

b) EditMode

c) StreamReader

d) StreamWriter


Answer:
A
Section Reference:
Section 6.1

58. To add data to a file and add an end of line marker, use the :

a) Write method.

b) WriteLine method.

c) Peek method.

d) WriteToEnd method.


Answer:
B
Section Reference:
Section 6.1

59. The WriteLine method adds:

a) an end of file marker after the data has been written to the file.

b) an end of line marker after the data has been written to the file.

c) an end of file marker before the data is written to the file.

d) an end of line marker before the data is written to the file.


Answer:
B
Section Reference:
Section 6.1


60. The key difference between a Sub procedure and a Function is:

a) a Sub returns a value, while a Function does not.

b) a Function returns a value, while a Sub does not.

c) a Sub can only be Public in scope, while a Function can be Public or Private.

d) a Sub can only be Public in scope, while a Function can only be Private.


Answer:
B
Section Reference:
Section 6.2

61. To open a file for read access, use the ________________ object.


Answer:
StreamReader
Section Reference:
Section 6.1

62. To open a file for write access, use the ________________ object.


Answer:
StreamWriter
Section Reference:
Section 6.1

63. If a file is arranged with each record on a line, use the __________________ method to read one record at a time.


Answer:
ReadLine
Section Reference:
Section 6.1

64. To test to see if you are at the end of the file, use the _______________ method.


Answer:
Peek
Section Reference:
Section 6.1

65. The _________________ method reads a specified number of characters from a file.


Answer:
Read
Section Reference:
Section 6.1

66. When using the StreamWriter object, to open a file so that data is written to the end of the file rather than overwriting existing data, the ________________ property must be set to True.


Answer:
AppendMode
Section Reference:
Section 6.1

67. The _________________ method appends an end of line marker after data has been written to the file.


Answer:
WriteLine
Section Reference:
Section 6.1

68. The ___________________ method dissociates a file from the StreamWriter object, releasing computer resources.


Answer:
Close
Section Reference:
Section 6.1

69. Given a save file dialog control named cdlSave, the _________________ method will display the Save As dialog box.


Answer:
ShowDialog()
Section Reference:
Section 6.1

70. The file selected by the user from the open file dialog is stored in the _________________ property.


Answer:
FileName
Section Reference:
Section 6.1

71. To have a file open dialog display only text files, set the ______________ property to “Text Files(*.txt)|*.txt”


Answer:
Filter
Section Reference:
Section 6.1

72. The characteristic of a class that allows another class to extend its methods and properties is:

a) encapsulation.

b) instantiation.

c) inheritance.

d) polymorphism.


Answer:
C
Section Reference:
Section 12.1

73. All of the following are advantages of building classes and using objects except:

a) code reusability.

b) easy maintainability.

c) more flexible data validation rules.

d) easier project management.


Answer:
C
Section Reference:
Section 12.1

74.  Class members that cannot be instantiated are recognized as:

a) class members.

b) inheritable members.

c) instance members.

d) static members.


Answer:
D
Section Reference:
Section 12.1

75. Class members that can be instantiated are recognized as:

a) class members.

b) inheritable members.

c) instance members.

d) static members.


Answer:
C
Section Reference:
Section 12.1

76. Given an object named objStudent, the correct syntax to destroy the object is:

a) objStudent.Destroy.

b) objStudent.Delete.

c) Set objStudent = Destroy.

d) Set objStudent = Nothing.


Answer:
D
Section Reference:
Section 12.2

77.  Given an object named objStudent that is an instance of clsStudent, with a method named CalcGPA, the correct syntax to invoke the CalcGPA method is:

a) clsStudent.CalcGPA.

b) objStudent.CalcGPA.

c) CalcGPA.

d) clsStudent.objStudent.CalcGPA.


Answer:
B
Section Reference:
Section 12.2

78. Given an object named MyStudent, which is an instance of a class named Student, the correct way to refer to a public variable of the object named StudentID is:

a) StudentID.

b) Student.StudentID.

c) Student(StudentID).

d) MyStudent.StudentID.


Answer:
D
Section Reference:
Section 12.2

79. If an object is created with an object variable in a procedure, the object is destroyed:

a) when the procedure ends.

b) when the next copy of that object is created.

c) when the project ends.

d) when the garbage collector is invoked.


Answer:
A
Section Reference:
Section 12.2

80. The first line of a Public class named Student is:

a) Class Student.

b) Public Student.

c) Public Class Student.

d) Public Sub Student.


Answer:
C
Section Reference:
Section 12.2

81. To add a class module to a project:

a) select Add Class from the Project menu.

b) select Add File from the Project menu.

c) select Add Class from the File menu.

d) type the statement Class in a form module.


Answer:
A
Section Reference:
Section 12.2

82. Public variables in a class are exposed as:

a) properties of the class.

b) methods of the class.

c) events of the class.

d) constructors of the class.


Answer:
A
Section Reference:
Section 12.2

83. Public procedures in a class are exposed externally as:

a) properties of the class.

b) methods of the class.

c) events of the class.

d) constructors of the class.


Answer:
B
Section Reference:
Section 12.2

84. Public variables in a class module exist:

a) throughout the life of the project.

b) until another object is instantiated from the same class.

c) until the object created from the class is destroyed.

d) until the computer is shut down.


Answer:
C
Section Reference:
Section 12.2

85. The procedure that is used to return the value of a property is:

a) Get.

b) Set.

c) Return.

d) Value.


Answer:
A
Section Reference:
Section 12.2

86. The correct syntax to create a property called Name that returns a string is:

a) Property Name().

b) Name() as String.

c) Property Name() as String.

d) Public Property Name() as String.


Answer:
D
Section Reference:
Section 12.2

87. Given a class named Student of a Long type, the correct syntax to create an instance of Student and assign it to a variable named MyStudent is:

a) Dim MyStudent as Long().

b) Dim MyStudent as New Student().

c) Dim MyStudent as Student().

d) Dim MyStudent = Student().


Answer:
B
Section Reference:
Section 12.2

88. The procedure that is often used to set the initial states for an object is the:

a) instantiator.

b) encapsulator.

c) constructor.

d) AddHandler.


Answer:
C
Section Reference:
Section 12.2

89. The procedure that is automatically executed when an object is created from a class is:

a) New().

b) Main().

c) Event().

d) Instance().


Answer:
A
Section Reference:
Section 12.2

90. The statement that can be used to hook an event with its handler at runtime is:

a) AddHandler.

b) Handles.

c) Handler.

d) Hook.


Answer:
A
Section Reference:
Section 12.3

91. A(n) ____________ is a code template that defines the characteristics of an object.


Answer:
class
Section Reference:
Section 12.1

92. A(n) __________________ is instantiated from a class.


Answer:
object
Section Reference:
Section 12.1

93. Public variables of a class module must be referenced with the ________________ as the qualifier.


Answer:
object name
Section Reference:
Section 12.2

94. Public variables in a class are recognized as __________________ of the object.


Answer:
properties
Section Reference:
Section 12.2

95. An object can be destroyed by setting it to __________________.


Answer:
Nothing
Section Reference:
Section 12.2

96. An object can be ______________________ by setting it to Nothing.


Answer:
destroyed
Section Reference:  Section 12.2

97. The ________________ procedure is used to set the value of a property.


Answer:
Set
Section Reference:
Section 12.2

98. An instance of a class must be declared with the ________________ keyword.


Answer:
New
Section Reference:
Section 12.2

99. Given a class named Student, with a property of StudentID and an instance of that class named MyStudent, the correct syntax to set the value of the StudentID property to 23456 is:


Answer:
MyStudent.StudentID = 23456
Section Reference:
Section 12.2

100. Another term for the New procedure is the __________________.


Answer:
Constructor
Section Reference:
Section 12.2

101. The database model under which a database is a collection of tables containing rows and columns is the:

a) hierarchical model.

b) parent-child model.

c) relational model.

d) network model.


Answer:
C
Section Reference:
Section 9.1

102. Each row in a database table represents a:

a) field.

b) record.

c) byte.

d) primary key.


Answer:
B
Section Reference:
Section 9.1

103. Each column in a database table represents a:

a) field.

b) record.

c) byte.

d) primary key.


Answer:
A
Section Reference:
Section 9.1

104. The language that is used to define tables is the:

a) data manipulation language.

b) schema.

c) data definition language.

d) structured query language.


Answer:
C
Section Reference:
Section 9.1

105. The language that allows the user to manipulate data in the table is the:

a) data manipulation language.

b) schema.

c) data definition language.

d) ADO.net


Answer:
A
Section Reference:
Section 9.1

106. The correct syntax to retrieve the StudentID, FirstName, and LastName fields from a table named Students is:

a) Select (Students.StudentID, Students.FirstName, Students.LastName).

b) Select StudentID, FirstName, LastName.

c) Select StudentID, FirstName, LastName from Students.

d) Select Students: StudentID, FirstName, LastName.


Answer:
C
Section Reference:
Section 9.1

107. The correct syntax to retrieve the StudentID, FirstName, and LastName fields from a table named Students and sort by LastName, then FirstName is:

a) Select StudentID, FirstName, LastName from Students Order by LastName, FirstName.

b) Select StudentID, FirstName, LastName from Students Sort LastName, FirstName.

c) Select StudentID, FirstName, LastName from Students Sort Order: LastName, FirstName.

d) Select StudentID, FirstName, LastName from Students Sort by LastName; FirstName.


Answer:
A
Section Reference:
Section 9.1

108. The correct syntax to retrieve the StudentID, FirstName, and LastName fields from a table named Students for all students whose last name is Smith is:

a) Select StudentID, FirstName, LastName from Students Order by LastName = Smith.

b) Select StudentID, FirstName, LastName from Students Where LastName = Smith.

c) Select StudentID, FirstName, LastName from Students Where LastName is ‘Smith’.

d) Select StudentID, FirstName, LastName from Students Where LastName = ‘Smith’.


Answer:
D
Section Reference:
Section 9.1

109. The correct syntax to retrieve the StudentID, FirstName, and LastName fields from a table named Students for all students whose last name starts with S is:

a) Select StudentID, FirstName, LastName from Students Where LastName = ‘S%’.

b) Select StudentID, FirstName, LastName from Students Where LastName Like ‘S%’.

c) Select StudentID, FirstName, LastName from Students Where LastName Like ‘S’.

d) Select StudentID, FirstName, LastName from Students Where LastName Like ‘S?’.


Answer:
B
Section Reference:
Section 9.1

110. The database engine that drives MS Access databases is:

a) Jet.

b) Access.

c) SQL Server.

d) ODBC.


Answer:
A
Section Reference:
Section 9.2

111. The object that serves as an interface between the dataset and the data source is the:

a) provider.

b) connection.

c) data set.

d) data adapter.


Answer:
D
Section Reference:
Section 9.2

112. The type of data adapter that works with any generic database server is the:

a) SQL data adapter.

b) OleDB data adapter.

c) ODBC data adapter.

d) Oracle data adapter.


Answer:
B
Section Reference:
Section 9.2

113. ADO.NET generates a dataset based on:

a) the connection.

b) the StreamReader.

c) the SQL Select statement.

d) A and C.


Answer:
D
Section Reference:
Section 9.2

114. The method of the data adapter that will load the dataset is:

a) Fill.

b) Load.

c) DataSource.

d) SelectCommand.


Answer:
A
Section Reference:
Section 9.2

115. The correct syntax to select records from a table named Students based on a StudentID entered at runtime is:

a) Select StudentFirstName, StudentLastName from Students Where (StudentID = ?).

b) Select StudentFirstName, StudentLastName from Students.  

c) Select StudentFirstName, StudentLastName from Students Where (Parameter = StudentID).

d) Select StudentFirstName, StudentLastName from Students Where (Parameter = ?).


Answer:
A
Section Reference:
Section 9.2

116. The method that removes an existing dataset from memory before loading a new one is:

a) Delete.

b) ReDim.

c) ReLoad.

d) Clear.


Answer:
D
Section Reference:
Section 9.2

117. The method of the data adapter that makes changes to the database is:

a) Change.

b) Update.

c) Insert.

d) AcceptChanges.


Answer:
B
Section Reference:
Section 9.2

118. The method of the dataset that is called after the database update to update the dataset itself is:

a) Change.

b) Update.

c) Insert.

d) AcceptChanges.


Answer:
D
Section Reference:
Section 9.2

119. The object that is used by the data adapter to locate and connect to the database is:

a) the Connection object.

b) the DataSource object.

c) the Provider object.

d) the DataSet object.


Answer:
A
Section Reference:
Section 9.3

120. In the connection string, the ______________________ specifies the database driver used to connect to the database.

a) data source

b) provider

c) Select statement

d) dataset


Answer:
B
Section Reference:
Section 9.3

121. The Connection object requires a ________________________, which provides information on the provider and location of the database.

a) data adapter

b) command object.

c) connection string.

d) provider string.


Answer:
C
Section Reference:
Section 9.3

122. The correct syntax to return all rows and all fields from a table named Employees is ____________:


Answer:
Select * from Employees
Section Reference:
Section 9.1

123. Given tables named Employees and Departments, where DeptID is in both tables, the _________________ operation will return records from both tables where Employee.DeptID matches Departments.DeptID.


Answer:
inner join
Section Reference:
Section 9.1

124. The __________________ is an object that serves as an interface between the dataset and the data source.


Answer:
data adapter
Section Reference:
Section 9.2

125. The ___________________ property binds a control to a dataset.


Answer:
DataSource
Section Reference:
Section 9.2

126. To specify a parameter where a value is provided during run time, code the Where clause with a _______.


Answer:
?
Section Reference:
Section 9.2

127. To write changes to the database, use the data adapter’s ______________ method.


Answer:
Update
Section Reference:
Section 9.2

128. The data adapter’s ______________________ property is used to select data for the dataset.


Answer:
SelectCommand
Section Reference:
Section 9.2

129. The __________________ object is used by the data adapter to connect to the database.

130. Answer:
Connection
___________________ enable the server to provide functionality that can be used by other computers on the Internet.


Answer:
Web services
Section Reference:
Section 14.3

131. Web services can be called across the Web and exchange data with other components using _________.


Answer:
XML
Section Reference:
Section 14.4

132. A component that can be called by other applications from a remote site on the Internet is a:

a) Web Component.

b) Web Form.

c) XML Form.

d) Web Service.


Answer:
D
Section Reference:
Section 14.4

133. With Web services, data is exchanged with other components using:

a) HTML.

b) VBScript.

c) XML.

d) IIS.


Answer:
C
Section Reference:
Section 14.4

134. An attribute declaration for a Web service must be surrounded with:

a) parentheses().

b) angle brackets(<>).

c) single quotes(‘’)

d) exclamation marks(!!)


Answer:
B
Section Reference:
Section 14.4

135. Functions in a Web service must be specified with the:

a) WebMethod attribute.

b) Protected Method keyword.

c) WebClass attribute.

d) Public Method keyword.


Answer:
A
Section Reference:
Section 14.4
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